
      
  Demo Walkthrough
  Grady Profile™ v.3
  Sampler Examples

Introduction
Grady Profile can be customized for any portfolio user or purpose. This version of the Walkthrough is in-
tended for the Sampler Demo with examples for a range of students, K-College. Other demos available at 
www.aurbach.com address K-5, 6-12, college and special education. For a personal portfolio see Toot!®.

Two companion documents may be helpful: Whats_Missing.pdf addresses elements of the 
Grady Profile suite omitted from the Demo; About_Portfolios.pdf speaks to a general audience 
about portfolio content, organization, exhibits, reflection, etc. While most security privileges are 
turned on, networking, spell checking and program help are turned off in this demo.

Installer
The Installer places the following on your computer: 

 
Three Folders in your 

Documents/My 
Documents Folder

Installed with 
Grady Profile Demo

Grady Profiles Demow, Ann_Sampler.gp3 
Demow, Ann_Sampler.bag

Extra Exhibits Media samples

Grady Demo Docs Walk-w-Sampler.pdf
About_Portfolios.pdf 
Passwords.txt, 
PriceList.pdf, 
Quickstart.pdf, 
Read_Me_gp3.pdf, 
What’s_Missing.pdf

  

 

The Walkthrough

1. Run Grady Profile: Double click the Grady Profile Demo icon on the desktop.

2. Login  a.  Select Demow, Ann Sampler.gp3 and click Choose.
�   b.  Select Demow, Ann Sampler and click Login.
�   c.  Enter the password grady3 and click OK. (The Guest password is guest.)
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3. The Portfolio Click OK again. The first card,Welcome, comes up.

Note: The portfolios you design with Grady Profile will look very different from this one; 
it depends on what data and artifacts you want and how you wish to organize them.

4.  Help Click the Read Me Help button. Every card in the demo has two Help buttons.

a.  Custom Help The magenta Help button (top left of demo cards) has content 
credits and specific help for the card. This is a Custom Help item which could be 
used for instructions to students or additional information for parents. Close this 
Help, but do open it if you have questions elsewhere.

b.  Disabled In this demo, the blue Help button in the header normally links to ex-
tensive help files that ship with Grady Profile. These are disabled to keep the demo down-
load small.

5. Graphic Exhibit Double-click the photo to see it full-size. Or, click it once to select it; 
then on the Actions menu, choose Open in New Window. 

The image is held in a graphic exhibit item, one of seven ways to keep artifacts. Close the 
graphic window.

 
7 Exhibits: External File, Graphic, Movie, Reading, Sound, Text, Web

6.  Sound Exhibit Click the ear button to listen to the sound exhibit. Click again to stop it. 
On the Actions menu, choose Open in New Window (or double click the white border 
around the button) to see the sound control panel. Click Play, the green arrow. Click Stop 
and Cancel to close it. Can’t Hear it? Slide the volume button to the right. Check the set-
tings on your Sound control panel: be sure mute is off, output sound level is up, speakers 
are plugged in and turned on.

7. Text  Click on the paragraph, Welcome to the sampler version..., which is a text exhibit. On 
the Actions menu, choose Open in New Window which would be a good way to read 
lengthy reports and essays. Optional Try It: If you want to bring in your own photo, 
sound and text right now, continue with steps 8 through 10; otherwise, skip to step 11.

Grady Profile v3 Demo Sampler        Aurbach & Associates, Inc.          800•774•7239          2 of 12



8. Optional New Graphic In the area labeled Your Turn, double-click the box under Photo, 
which is an empty graphic exhibit. Then locate a photo or other graphic image (e.g., jpeg, 
gif, tiff, png...) and click Open. The Edit Exhibit panel comes up. To crop the image, con-
tinue with 8a; to keep the image as it is, click OK and skip to 9.
� a.  Optional Cropping To crop the image, click and drag the cursor across the im-
age. Use the Magnification menu to see more or less of the image. When the area inside 
the dotted rectangle represents the area you want to keep as the exhibit, click OK. 

� b.  Optional Clear It To delete the image, select it; choose Clear on the Edit menu.

9. Optional New Sound Double click the Hello ear button, an empty sound exhibit. 

� a.  Click OK on the sound options panel to see the recording panel. 
� b.  Click Rec and speak into your computer microphone. 
� c.  Click Stop.
� d.  Click OK to save the recording.
� e.  Click the Ear once to listen to your recording.

10. Optional New Text The box labeled Welcome is an empty text exhibit. Click in the box 
and type. Use the Windows Format menu or Macintosh Text menu to change the format. 
Alternatives: Copy and paste text from a word processor document into the text exhibit. 
Or, drag and drop RTF or plain text files to it. To clear the exhibit, select all the text and 
click the Backspace or Delete. 

11. Navigating In the header, click and hold the Topic menu, and choose Student Infor-
mation. The cards listed on the menu are sub-sections (topics) of the Personal domain.

12. Pop Up Menu Reset the Grade pop up menu. A popup menu is one of several items 
that offer choices for data collection. Do you see another popup menu on this page? 
(Transportation menu)

13. Date Fields Enrolled and Exit Date are date items. Optional: Replace the Enrolled date 
with “Grady” and click Tab. The field turns red (an alert) because “Grady” is not a date. 
Replace “Grady” with a date and the alert disappears.

� Alert Color Red is the default warning/alert color. If you prefer another color, �
� open Preferences, click the highlight color and choose another on the Colors �
� panel. Find Preferences on the:
�      • Windows Tools menu (on the Grady Profile Demo menu, top left of the screen) 
�      • Macintosh OS 9 Edit menu  or  
�      • Macintosh OS X Personal Profile Demo menu 
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14. Tables On the Scholastic History table, add a row: click the + button at the bottom of 
the table. Then: 
� a. Enter Information Click the left cell of the new row and type: 
� � Portfolio Award [click Tab] 11 [Tab] 2005. 
� b. Reorder Rows Drag the row’s grabber (the little hand) up �
�     ward and let go. 
� c. Remove Rows Select a grabber; click the minus button (bottom 
�     of the table) and Delete on the confirm panel.

15.   Posted Notes  Look at the posted notes under Double Click Me on the Stu-
dent Information card. The  text note explains how to work with these “sticky” notes, 
which could be sound notes or card links (Contact Information). Try It: To create a posted 
note, find an empty place on the card and Ctrł/click on Windows or Option/click on 
Macintosh. Make a selection (text note, sound note or card link) and click OK. Card link 
creates a hyperlink to another card in the portfolio.

16. Demographics On the card header, with domain set to Personal, change the topic to 
Demographics for School Reports, a card tailored with aggregate and disaggregate reporting 
in mind. If your reporting requirements are different, you can customize a page like this 
to reflect your requirements. Optional: Click and hold the topic menu to see other topics 
included in this particular Personal domain. You could have more, fewer, or different top-
ics relating to Personal information; it’s all a matter of customizing or tailoring. 

17. Portfolio and Tables of Content On the card header, change the domain to Exhibits. 
The topic menu becomes Elementary Contents displaying a table of contents that:

� •   Provides access to example cards, a deeper level into the portfolio and the place 
�       where the portfolio artifacts usually are kept
� •   Lists all the examples (instances) associated with the topic
� •   Identifies example card templates (card layouts that can be reused)
� •   Creates and deletes example cards

Even if Elementary education is not your chief interest, staying with us through step 23 which will 
introduce key features of Grady Profile relevant to all levels and interests.

18. Example Card  On the table, select the second row, Writing Grades 4 and 5, and click 
the little Eye button. The example card opens showing thumbnails of Samples 1 and 2, 
graphic and text exhibits respectively.

� a.  Double-click Sample 1 ( graphic exhibit) to view it.

� b.  Click on Sample 2 (a text exhibit) and choose Open in New Window on the 

Not-
Selected

Selected
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�      Actions menu.
�
19. Descriptor Block  Below the exhibits is a descriptor block, with writing benchmarks.
Try It You are logged on as the student, Ann Demow, so her 
evaluation is active.

� a.  Enter or change Ann’s evaluations. Drag the 
�       symbol- button. Or, click and hold it for a pop-up �
�       menu. Or, click the tiny + and – buttons.

� b.  What does 0 - 6 mean? Click the question mark to �
�      see the symbol legend. 

� c.  Click Show Evaluators to see who else has evaluated this work. Click Miss �
�       Nelson and OK; her marks are gray: you can see, but not change them. 

20. Organization Having seen an example card, you are now all the way into the richest 
level of the portfolio. Note that on the card header: The student’s name is at the very top. 
Timeframe is next; this demo has only one; there could be one for each year, semester, 
quarter or other marking period. The substance of the portfolio is organized by domains, 
topics and examples.

21. Reading Exhibit: On the Example Menu in the card header, choose Reading Grade 1.

a.  Click the center of the Fall Sample button 
to hear the student read. Click again to stop 
the sound. Double-click on the white border 
of the button to see the words the student is 
reading. Click Play.  Note: The teacher placed 
the text into a reading sample editor so it would appear on the screen for the student to read di-

Descriptor Block

To read along 
and listen, 
double click the 
white border.

To listen with-
out seeing the 
text, click here.
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rectly into the portfolio. Cancel this reading exhibit. 

b. Listen to the Spring sample and compare it with the Fall reading. A comparison like 
this, showing growth over time, is at the crux of the portfolio culture.
Sound vs Reading Exhibit: A sound exhibit has only sound; a reading exhibit has sound 
with text (or a picture which can be used for speaking). Reading exhibits are a good place 
for schools to start using electronic portfolios because no additional equipment is needed, 
and the results can be dramatic. Very young students can hear improvement and identify 
skills that need more work. Parents understand quickly what the teacher is telling them 
about how their child is reading when they hear their child’s reading sample.

22. Table with Accumulator On the Example menu, choose Book List. 

a. Note the Sum at the bottom of the Minutes column. Change a number in the Minutes 
column, tab to another column and watch the Sum update.

b. Try typing letters instead of numbers in the Minutes column. The column is set to ac-
cept only integers.

23. Flexible Format On the Topic Menu in the card header, choose Middle-High School 
Contents and open the Coyote Waits example.

Format Which exhibit will you use for artifacts? Sometimes the artifact decides for you, 
as with a movie clip or a web site. The Coyote Waits example card has the same artifact 
repeated four times to show that there may be more than one way to display student 
work. Your choice of format, i.e., your choice of exhibit, will depend on the artifact, the 
applications available to you and the applications likely to be available to your audience. 
On this card, from left to right:

• The Word® version requires Microsoft Word to open. If you have Word, click 
the exhibit button to launch it and read the piece as a Word document. This is an 
external file exhibit — the document icon on the button is the clue. External file ex-
hibits can hold any file your computer can make. Note: A computer that does not 
have the document’s application installed will not be able to open the exhibit; e.g., a computer sans 
Microsoft Word would not be able to open the Word version of Coyote Waits. 

• The PDF ® version, also an external file, opens with Adobe Reader®. The original 
word processed book report was converted to a PDF (portable document for-
mat). Converting exhibits to PDF files is a practical choice for portfolios because 
the content cannot be changed by viewers; and, because Adobe Reader is free at 
www.adobe.com, it is widely used. PDF conversion is often an option on Save 
As or Print panels.
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• The Formatted Text version displays the piece in a text exhibit, 
which is Grady Profile’s word processor. Its window is very small 
to make it tidy on this card layout. To read it, click anywhere on the 
text to select the exhibit and on the Actions menu, choose Open in 
New Window. This text was copied and pasted from the original 
word processor. Using the Grady text exhibit means the text can be 
read by anyone opening the profile, without regard for what other software is installed on 
their computer. 

• The Plain Text version was also copied and pasted from the 
original report. This is a long text field which differs from a text ex-
hibit text in two ways: 1) formatting and style are lost (it is plain 
text) and, 2) you cannot open this one in a larger window as with 
the Formatted Text version. However, this text frame could be en-
larged in tailoring to make it easier to read the text.

24. Optional  Middle School - High School Explore the other examples for Middle-High 
School by clicking the arrows in the card header.

� • Audio Reflection The Art card, 3-D Mask, in this section has a spoken 
� reflection in which the teacher interviews the student about the mask.
� • Foreign Language See the Magical Realism card.
� • Movie The Basketball card has a video exhibit and PE descriptors.

25. Optional  Special Education Choose Special Education Contents on the Topic menu. 
Select an Exhibit and click the Eye button on the table to open it.

� • Evaluate Progress The IEP Skills - Ann Demo card has a descriptor block, one �
� way to track and evaluate skills over time, and show evaluations by several team 
� members side by side.
� • Check boxes Interventions has an example of a check box item for recording �
� special services.
� • Table Meeting History records the special education team meetings.

26. Optional College To see the collegiate examples, choose College Contents on the Topic 
menu. Select an exhibit and click the Eye button on the table to open it.

� • Technical Portfolio The card for Lighting Albee’s A Zoo Story shows how 
� students in technical fields (Engineering, Science, Math, Computer Science, etc.) �
� can show examples of their work.
� • College Requirements One approach is offered on Write, Speak Think
� • Portfolio Writing Sample See Freshman Writing
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27. New Card, Templates To add a new card to the portfolio, click the New button in any 
example card header. Or, click New on any table of contents. 

� In either case, a new panel appears:

�

� a. Give the new card a descriptive name, “Winter Writing.”
� b. The date is already filled in; change it if you wish or tab through.
� c. Select an example card template. Grady Profile ships with some templates; most 
�     schools prefer to design their own to match their students’ needs. This is done �
�     in the Master Tailor program, part of the full Grady Profile suite.
� d. Click OK and the new, empty, example card is added to the portfolio. Tem- �
�      plates provide the layout and structure of cards, but not the content, artifacts, �
�     and evaluations which will vary from student to student. Right now you are �
�     working with one student’s portfolio; when you work with a full class of �
�     portfolios you will be using the Profile Manager (part of the Grady Profile �
�     suite) and you will be able to add an example card to every portfolio at once, �
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                   or choose which among them will receive the new card.

28.  Try It - Exhibits On the domain menu, choose Try It. The Seven Exhibits card comes 
up, a place for you to try bringing your own content into each exhibit. 

Extra Exhibits We hope you will use your own media, but if you do not have all the va-
rieties, look in the Extra Exhibits folder in your Documents or My Documents folder. 

Tips for Adding Artifacts �

• Choices Often there is more than one way to bring content into an exhibit. Use which-
ever you prefer: 
� + Drag and drop works for most exhibits. (Find the original, drag it to the exhibit 
�     and let go. The original remains in place on your computer drive.)

� + Select an exhibit and on the Actions menu choose the top item.

� + Double click the exhibit frame and navigate to a file. � �

� + For sound and reading exhibits, talk, read or sing, and record directly into the �
�     exhibit.

 • Guidance Check the Read Me help button, top left of the card. 

29. Try It - Fields On the topic menu, choose Fields to see a card which contains all of the 
ways for collecting information in Grady Profile, other than exhibits. Play with the fields, 
see what you can learn.

30. Try It - Tailoring Try your hand at tailoring (customizing) a page. Change the topic 
menu to Blank Card for Tailoring to see a card empty, except for the help button. The next 
few steps will show how to design portfolio pages by placing exhibits and fields on a 
card.

31.  Design Mode In the lower left corner of the card, change the mode menu from 
browse to design.  Two additional panels appear on the screen: 

� � • an Item Palette with lots of items on it  
� � • an empty Item Inspector

Missing? If you do not see the item palette or item inspector, look on 
the Window menu. 
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32. Customizing the Portfolio

   a.  Place a field On the palette, drag the date field to the card.

The date field will be highlighted in red, alerting you that something more needs to be 
done. Look at the item inspector: 

b.  Required Identifier On the Item Inspector, place the cursor in the top right empty col-
umn across from Identifier and type something (“date” is fine). 
Why: Grady uses the field identifier for reporting. Although reporting is not included in 
this demo, every field is required to have an identifier that is unique on the card. Thus, if 
you have two date fields on the same card, distinguish between their identifiers, e.g., 
“date1” and “date2”, or  “birth_date” and “exitDate.” It won’t matter what it is as long as 
it is unique for the card. If the identifier is missing or repeated on another item’s inspector 
for the same card, the field will remain red until the identifier is unique.
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• Note on Reporting Grady Profile has basic printing and reporting capabilities. An Ad-
hoc Reporting option is available for advanced reporting, data aggregation and disaggrega-
tion, output to files for transfer to other programs, and conversion to HTML for web post-
ing. 

c.  Prompt Text Type “Birth date” here and see what happens to the field. 

d.  Prompt Position Change the popup from Left to Above item. What happens?  

e.  Preview Take a look at the other properties on the date field inspector. Try setting the 
date format to long or abbreviated. Then switch the mode (lower left of the card) to Pre-
view and type a date to see how data will appear in this field. Note: In Preview mode 
nothing is saved; use it to see if you need to make a field larger, move the prompt position 
or change other properties on the inspector. 

f.  Delete Items To remove an item from a card, select it and on the Edit menu, choose 
Clear, or click Delete or Backspace.

33.  Try It Drag some other items to the card. Note that their item inspectors vary from 
item to item. Remember to fill in the identifier property for each.

34.  Plan a Card Think of a unit you have taught and answer three questions: 

� � i) What did students produce? (I.e., a paper, an oral report, a drawing, a 
� � 3-D exhibit, a web-page, a movie, a read-aloud...) 

� � ii) Which of the seven Grady exhibits would best display it? (External file, �
�       � graphic, movie, reading, sound, text, web)

� � iii) List two or three concepts or skills students honed through the unit.

a. Exhibits In design mode (lower left corner); drag an exhibit from the palette to the �
card and fill in its inspector. You can have several of the same exhibit, but each needs a 
unique identifier on its inspector. These will display the work identified in 34i above.

b. Descriptors Drag a descriptor block to the card. 
• Select the descriptor block; on its inspector, fill in Identifier and set the Symbols menu. 

• Click Edit Descriptors for the descriptor block editor. 
� + At the top of the editor panel, enter a goal and standards.
� + Below that, be sure to click Show Goal and Show Standards.
� + Click the Add button.
� + Click in the descriptor column of the new line and type one of the � �
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�    concepts or skills for your unit from 34iii above. Add another skill or � �
�    two, and when done click OK.
� + Set the Symbols menu on the inspector.
� + Close the item inspector.

c. Reflection Drag a sound exhibit to the card; fill in the inspector, type Reflection � �
as the prompt. Alternately, the reflection could be written in a text field. Written or spo-
ken, an honest reflection is the critical element of the portfolio.

�

Reflection is the place for one or more of the following:

• Tell how well the project or artifact was done

• Place it in context (was there an assignment or a set of constraints?)

• Make connections with prior experience and knowledge

• Tell about an insight gained or a hunch confirmed

• Suggest what might be done differently another time

• Set a goal for the future 

d.  Add Content Switch back to browse mode. Congratulations! You have designed an 
electronic portfolio page. Add an artifact to the exhibit, evaluate it and add a reflection 
about the artifact. Alert: You are starting a portfolio culture. Careful, it’s catchy.

35. Enjoy Mosey around Grady Profile and have fun exploring. When you are finished, 
quit the program and send us some feedback.

� � �

Thank you for reviewing Grady Profile 3.
Please let us hear from you:

      800•774•7239 or 314•726•1321
      sales@aurbach.com
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